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Introduction 
Welcome to FM23-1L Introduction to dbConnect for Facilities Management. This lab is designed to 
give you an overview of the dbConnect features of AutoCAD within the context of a real-world, 
facilities management application. You will be working with an AutoCAD drawing of an office floor 
plan and an Access database. Using only the out-of-the box dbConnect tools, you will build a 
simple space management system. 

The Drawing 
The AutoCAD drawing included with this lab is an architectural plan of one floor of an office 
building. The drawing was created with the intent of eventually linking it to a database. Some very 
simple rules were followed, which will simplify the transition to a database-linked drawing. 

• There are closed polylines on the A-SPACE layer that define the perimeter of each space. 

• The polylines for offices are color coded by department. 

• For non-office space, the polyline color is set to "bylayer." 

• Each space is labeled with a text object, which is on the A-EMPNAM layer. 

• For offices and cubicles, the label is the name of the employee and the color is set to 
"bylayer." 

• For vacant offices, the label reads "Vacant" and the text color is set to red. 

• For vacant offices, the polyline color is set to "bylayer." 

• For non-office space, the label describes the use of the space, and the color is set to yellow. 

The Database 
This lab also includes an Access database (office.mdb) containing the following four tables: 

• EMPLOYEE – Contains one row per employee. 

• DEPARMENT – Contains one row per department. The EMPLOYEE table has a foreign key 
column that indicates which department each employee belongs to. 

• SPACES – Contains one row per space. A space can be a cubicle, enclosed office, conference 
room, etc. This table contains a foreign key column that links it to the employee that 
currently occupies the space. 

• USE_TYPES – Contains one row for each distinct type of space. Examples of space types are 
Office, Conference Room, Storage, Library, etc. 

Below is a relationship diagram for the database. 
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The database also includes a view (also called a “Query” in MS Access) called SPACES_QUERY 
that returns one row per space, and joins the other three tables to create a dynamic view of all the 
data in the database from the perspective of each space. For linking purposes, dbConnect makes 
no distinction between tables and views in a database. This lab uses this view as the primary 
linking table for dbConnect. Linking to a view rather than a table has significant advantages: 

• It gives you access to columns in related tables for labeling purposes. 

• It makes querying multiple tables much easier. 

• The view can be based on other dynamic data in your database, allowing you to create more 
dynamic labels. 

• The view itself is easily redefined to include additional tables or columns as your database 
grows. 

Below is a diagram showing the resulting structure of the SPACES_QUERY view. 

 

Lab Exercises 
Exercise 1. Configuring a Data Source 

Exercise 2. Using the Data View Window 

Exercise 3. Creating Links to Graphical Objects 

Exercise 4. Creating Freestanding Labels 

Exercise 5. Creating a Simple Query 

Exercise 6. Creating a Range Query 

Exercise 7. Viewing Linked Records and Linked Objects 

Exercise 8. Using the Query Builder 

Exercise 9. Using the SQL Query Tab 

Exercise 10. Using Link Select 

Exercise 11. Exporting Links 
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Lab Exercises 

Exercise 1. Configuring a Data Source 
This exercise walks you through the configuration and connection to the office database. 

1. Start AutoCAD. 

2. From the Tools menu, choose dbConnect. This displays the dbConnect Manager. A 
dbConnect pull-down menu is also added to the AutoCAD menu bar. 

Tip: You can also toggle the display of the dbConnect Manager by typing CTRL+6. 

3. Right-click the Data Sources branch in the dbConnect Manager and choose Configure 
Data Source… from the shortcut menu. The Configure a Data Source dialog box is 
displayed. 

4. Type "office" as the data source name, and click OK or press ENTER. This launches the 
Data Link Properties dialog box. 

5. On the Provider tab, select Microsoft Jet 4.0 OLE DB Provider in the list of OLE DB 
Providers, and click Next >> to switch to the Connection tab. 

6. Click the ellipsis icon located just to the right of the file box and browse for the office.mdb 
file. 

7. Click Test Connection to verify that a connection can be made. 

8. Click OK. 

9. Double-click the office data source in the dbConnect Manager window to establish a 
connection. 

Exercise 2. Using the Data View Window 
This exercise introduces you to the Data View window 

1. Double-click the EMPLOYEE table in the dbConnect Manager window to display the Data 
View window for this table. 

2. Click in the first field under the TITLE column and type "Project Manager." As you are 
typing, notice that there is a small "pencil" icon in the row selector (on the far left side of 
the table grid). 

3. Press the down arrow key to advance to the next row. Notice that the row selector now 
shows a Greek "delta" symbol, indicating that changes have been made to that row. There 
is also a "delta" symbol in the table selector (in the top left corner of the table grid) 
indicating that changes have been made to the table, but have not yet been committed to 
the database. 

4. Continue changing the TITLE value in the next three rows to "Engineer," "Architect," and 
"CAD Specialist" respectively. 

5. Right-click in the table selector (in the top left corner of the table grid) to display the table 
selector shortcut menu. Using this menu gives you the option to commit changes or restore 
the table to its original state. Either option will close the Data View window. 

6. Choose Commit to save the changes and close the Data View window. 
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Exercise 3. Creating Links to Graphical Objects 
In this exercise, you will start linking the space polygons to rows in the SPACES_QUERY view. 

1. Open office.dwg. This drawing contains a floor plan of an office. Each space is represented 
by a closed polygon. 

2. Right-click the SPACES_QUERY table and choose New Link Template. The New Link 
Template dialog box is displayed. 

3. Accept the default link template name of SPACES_QUERYLink1 by clicking Continue. This 
takes you to the Link Template dialog box, where you indicate which columns in the table 
you are using as your link columns. 

4. Click the check box next to SPACE_ID to indicate the key column you are using, and then 
click OK. You should now see a SPACES_QUERYLink1 node in the dbConnect Manager 
just below parcels.dwg. 

5. Before you start creating links on entities, you must bring up the Data View window. Right-
click the SPACES_QUERYLink1 node and choose View Table. 

Tip: You may find it easier to "dock" the Data View window so that it does not obscure 
your drawing area.  To ensure that docking is enabled for the Data View window, 
right-click the Data View window toolbar and choose Allow Docking. Then drag the 
window by its title bar to one edge of the AutoCAD window. 

6. From the View menu, choose Named Views. 

7. On the Named Views tab of the View dialog box, select Exercise 3 and click Set 
Current. Click OK. 

8. In the Data View window, right-click any of the column headers and choose Sort from the 
shortcut menu. 

9. Choose EXERCISE_3 in the fist pick list in the Sort dialog box and then click OK. This will 
bring the spaces that correspond to the current view to the top of the grid in the Data View 
window. 

10. In the Data View window, click the row selector (just to the left of the row) for the row 
with the name Darryl Mckendrick. 

11. Locate the space on the floor plan that is labeled, Darryl Mckendrick. Click the Link 
toolbar button and select the polygon that encloses that space. 

12. Press ENTER. 

Note: Notice that the row in the Data View window is highlighted in yellow and that the 
next row in the table has been selected. If your objects on the screen are in an order 
similar to the way they appear in the table, this feature makes it convenient for you 
to continue linking rows without having to select the next row in the Data View 
window each time. 

13. Repeat steps 11 and 12 and link the next row in the table to its corresponding space. 
Continue until all nine spaces (visible on the screen) have been linked. 

Tip: If you prefer to use the keyboard, you can use the DVLINK command to create the 
first link, and then you can simply press SPACEBAR or ENTER to repeat the command 
as you continue linking objects. 

14. Save the drawing. 



 Introduction to dbConnect for Facilities Management 

   6 

Exercise 4. Creating Freestanding Labels 
In this exercise, you will create labels – dynamic text objects that are linked to data in your 
database. 

1. Right-click the SPACES_QUERY table and choose New Label Template. The New Label 
Template dialog box is displayed. 

2. Accept the default label template name of SPACES_QUERYLabel1 by clicking Continue. 
This takes you to the Label Template dialog box. 

3. Right-click the text area and choose Select All. 

4. Select the Character tab and change the font height to 6”. 

5. Select the Properties tab and change the justification to Middle Center. 

6. Return to the Label Fields tab, select SPACE_LABEL from the field drop-down list and 
click Add. 

7. Click OK. 

8. In the Data View window, click the row selector (just to the left of the row) for the row 
with the name Darryl Mckendrick. 

9. Next to the Link toolbar button there is a small down arrow. Click this arrow and choose 
Create Freestanding Labels. Notice that the Link button icon changes to a label icon. 

10. Locate the space on the floor plan that is labeled, Darryl Mckendrick. Click the Label 
toolbar icon. At the command line, you are prompted to select an insertion point for the 
label. Select a point inside that space. 

Tip: As with links, you can type "DVLINK" at the command line to create the first label, 
and then you can simply press SPACEBAR or ENTER to repeat the command as you 
continue adding labels. 

11. Repeat step 11 until you have placed labels in each of the nine spaces that are visible on 
the screen.  

12. Erase the text objects that previously labeled each space. 

13. Save and close the drawing. 

Exercise 5. Creating a Simple Query 
In this exercise, you will use the Query Editor to highlight all the space polygons belonging to the 
Planning department. 

1. Open office2.dwg. This drawing is the same as office.dwg, except that all of the space 
polygons are linked to the database. 

2. Right-click the SPACES_QUERY table and choose New Query from the shortcut menu. 
This displays the New Query dialog box. 

3. Type "Planning Department" as the query name and click Continue. This takes you to 
the Query Editor. 

4. Make sure the Quick Query tab is selected. 

5. In the Field list select DEPT_NAME and make sure = Equal is selected in the Operator 
pick list. 

6. Click the Look up values button. This displays all the distinct values for the DEPT_NAME 
column. 
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7. Select Planning from the list and click OK. The text "Planning" now appears in the Value 
field. 

8. At the bottom of the dialog box, deselect the Indicate records in data view check box, 
and make sure the Indicate objects in drawing check box is selected. 

9. Click Store to save the query in the current drawing. The “Planning Department” query now 
appears as a node in the dbConnect Manager under the office2.dwg node. 

10. Click Execute. The dialog box is closed, and the spaces that belong to the Planning 
Department are highlighted (selected) in the drawing. 

Note: The objects are selected the same way they would be if you had picked them 
manually. To deselect them, simply press ESC a couple of times. You may also notice 
that when the dbConnect Manager window is open, you may need to click in the 
command prompt area or the graphics area to shift input focus so that ESC will work 
properly. 

Exercise 6. Creating a Range Query 
The Query Editor also provides an easy way to create a query based on a range of values. In this 
exercise, you will highlight the spaces whose area is between 70 and 80 square feet. 

1. Right-click the SPACES_QUERY table and choose New Query from the shortcut menu to 
display the New Query dialog box. 

2. Type "Space Area" as the query name and click Continue. 

3. Select the Range Query tab in the Query Editor. 

4. In the Field list, select AREA. 

5. Type "70" in the From field. 

6. Type "80" in the Through field. 

Tip: At any time during the query building process, you can see what your query looks 
like as an SQL statement by selecting the SQL Query tab.  If you do this, however, 
make sure you don't make any changes to the SQL statement. If you do, the Query 
Editor will reset itself if you try to go back to any other tab. 

7. Make sure the Indicate records in data view check box is deselected, and the Indicate 
objects in drawing check box is selected. 

8. Click Store to save the query in the current drawing. 

9. Click Execute to dismiss the dialog box and highlight (select) the space polygons that 
satisfy the query. 

Exercise 7. Viewing Linked Records and Linked Objects 
In this exercise, you will learn how to synchronize the drawing with the Data View window. 

1. Double-click the SPACES_QUERY table in the dbConnect Manager window to display the 
Data View window for this table. 

2. Dock the Data View window at the bottom or top of the AutoCAD window. 

3. From the Data View menu, choose Options. 

4. Under AutoPan and Zoom, make sure that Automatically Pan Drawing and 
Automatically Zoom Drawing are both selected. 

5. Set the Zoom factor to 60 percent. 
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6. Under Record Indication Settings, choose Show only indicated records. 

7. Choose OK. 

8. In the Data View window, double-click a row selector, and notice that AutoCAD zooms in 
on the linked polygon. 

9. Select multiple rows by holding down SHIFT. 

10. Right-click the row selector, and choose View linked objects from the shortcut menu. 
AutoCAD zooms so that the selected objects are visible. 

11. From the View menu, choose Zoom and then Extents. 

12. From the Data View menu, choose AutoView Linked Records. 

13. Select one or more space polygons in the AutoCAD window. Note that only the linked 
records are displayed in the Data View window. 

14. To reset the Data View window to show all records, simply double-click the 
SPACES_QUERY table in the dbConnect Manager window. 

Exercise 8. Using the Query Builder 
In this exercise, you will use the Query Editor to find conference rooms that have an area greater 
than 200 square feet 

1. Right-click the SPACES_QUERY table, and select New Query… from the shortcut menu. 

2. In the New Query dialog box, type “Large Conference Rooms” as the query name. 

3. In the Query Editor dialog box, select the Query Builder tab. When this tab is activated, 
the Query Editor shows a grid area with the headings Field, Operator, Value and 
Logical. 

4. In the first row of the grid, click in the first cell under the Field column. A pick list will 
appear with a list of available fields. 

5. Choose TYPE_NAME from the list of fields. 

6. In the Operator column, choose = Equal. 

7. Click in the Value column, and an edit box will appear with an ellipsis ("…") button. 

8. Click the ellipsis button and a dialog box will appear with the list of available values for the 
TYPE_NAME field. 

9. Choose Conference Room from the list and click OK. 

10. Click in the Logical column until you see the word "And." 

11. In the second row in the grid, choose AREA under the Field column. 

12. In the Operator column, select > Greater Than. 

13. In the Value column, type 200. 

14. Click Store to save the query in the current drawing. The “Large Conference Rooms” query 
now appears as a node in the dbConnect Manager under the office2.dwg node. 

15. At the bottom of the dialog box, make sure that both the Indicate records in data view 
and Indicate objects in drawing check boxes are selected. 

16. Click Execute. 
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Exercise 9. Using the SQL Query Tab 
In this exercise, you will copy an existing query and modify the SQL code in the Query Editor. 

1. Right-click the Large Conference Rooms query in the dbConnect Manager, and choose 
Duplicate from the shortcut menu. This will make a duplicate copy of the query, and put 
you in edit mode in the tree view to rename the new query. 

2. Type “Small Conference Rooms” as the new query name. 

3. Right-click the Small Conference Rooms query and choose Edit from the shortcut menu. 

4. Choose the SQL Query tab. The query that you built in the previous exercise is shown 
using SQL. The SQL query should read as follows: 

SELECT SPACE_ID, SPACE_LABEL, FIRST_NAME, LAST_NAME, TITLE, PHONE_EXT, 
DEPT_NAME, HAS_WINDOW, ENCLOSED, AREA, TYPE_NAME, EXERCISE_3 

FROM SPACES_QUERY 
WHERE ( TYPE_NAME = 'Conference Room' ) And  ( AREA > 200 )   

5. Change the AREA > 200 to AREA <= 200. 

Tip: You may need to scroll the query window horizontally to see this part of the query. 
You can also resize the Query Editor dialog box. 

6. Choose the Query Builder tab. A warning message is displayed to inform you that choosing 
a "previous" tab (meaning any tab to the left of the current tab) will reset the Query Editor 
dialog box to its default state. 

7. Choose No on the Warning Message dialog box to return to the Query Builder tab. 

8. Choose Check. This will check the syntax of the current SQL statement, without actually 
executing it. 

9. Choose OK to clear the SQL syntax message. 

10. Click Store to save the changes you made to the query. 

11. Choose Execute. 

Exercise 10. Using Link Select 
Link Select allows you to perform queries using a combination of SQL and graphical selection. In 
this exercise, you will find all the spaces that are designated as “File Area” in the top half of the 
floor plan. 

1. Zoom to the extents of the drawing. 

2. Right-click the SPACES_QUERYLink1 link template, and choose Link Select… from the 
link template shortcut menu. The Link Select dialog box is displayed. 

3. Choose Select in Drawing < and click the Select button. This will hide the Link Select 
dialog box and prompt you to select objects in the drawing. 

4. Imagine a horizontal line that divides the floor plan into two equal halves, and use a window 
to select all the objects in the top half of the floor plan. 

Note: Objects that are not linked with the current link template will automatically be 
filtered out of the selection. 

5. Press ENTER to complete the selection and return to the Link Select dialog box. This should 
select approximately 58 objects. The exact number of objects selected and the number of 
matching records found are displayed at the bottom of the dialog box. 
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6. Choose Intersect from the Do pick list at the top of the dialog box. 

7. Choose Use Query, and make sure the Quick Query tab is active. 

8. In the Field list, select TYPE_NAME. 

9. In the Operator pick list, choose = Equal. 

10. Click Look up values and choose File Area, then click OK. 

11. Click Execute. Notice the change in the number of objects and number of records displayed 
at the bottom of the dialog box. 

12. Make sure that the Indicate records in data view and Indicate objects in drawing check 
boxes are both selected. 

13. Click Finish. The objects that met the criteria are highlighted, and the Data View window 
appears with the corresponding rows displayed. 

Exercise 11. Exporting Links 
In this exercise, you will use the Export Links feature to populate the HAS_WINDOW field in the 
SPACES table with the correct value. 

1. Zoom to the extents of the drawing. 

2. Press ESC a few times to be sure that no objects are selected. Also, close the Data View 
window if it is visible. 

3. From the dbConnect menu, choose Links and then Export Links. 

4. Using the “Fence” selection method, draw a fence line through all the spaces that are 
adjacent to an exterior wall. 

5. Press ENTER to complete the selection. This will display the Export Links dialog box. 

6. In the Save as type pick list, choose native database format. 

7. Type "WINDOW_OFFICES" in the File name field. 

Note: The Included Fields list can be used to choose specific fields from the linked table to 
export. For this exercise, you only need to export the SPACE_ID field. 

8. Click Save. After a short delay, the dialog box closes, and the WINDOW_OFFICES table 
appears under the office data source node in the dbConnect Manager window. 

9. Right-click the SPACES table and choose New Query. 

10. Leave SPACESQuery1 as the default name and choose Continue. 

11. Choose the SQL Query tab. 

12. Delete any existing text, and type the following SQL statement in the text area: 

UPDATE SPACES SET HAS_WINDOW='Y' 
WHERE SPACE_ID IN (SELECT SPACE_ID FROM WINDOW_OFFICES) 

13. Choose Execute. A dialog box will display that shows the number of SQL statements that 
were executed, and the number of rows affected. 

 

 
 




